STYLE GUIDE:

Guidelines for Transcribing and Editing Oral Histories

Adapted from “Style Guide: A Quick Reference for Editing Oral Memoirs.”
© 2007 Baylor University Institute for Oral History
# TABLE OF CONTENTS

Transcripts and Transcript Summary ................................................................................. 2
Formatting Guidelines ........................................................................................................... 3
Completing a Transcript ....................................................................................................... 4
Sample Transcript ................................................................................................................ 5-6
Transcripts 101 .................................................................................................................... 7
Inaudible Spots ..................................................................................................................... 7
Brackets ............................................................................................................................... 7
Common Questions .............................................................................................................. 7
Improper Grammar ............................................................................................................. 8
Dashes ................................................................................................................................ 8
Ellipses ............................................................................................................................... 8
False Starts .......................................................................................................................... 9
Feedback Words .................................................................................................................. 9
Filler Words .......................................................................................................................... 9
Dates .................................................................................................................................. 10
Spelling Guidelines ............................................................................................................ 10
Proofreading ....................................................................................................................... 11
Abbreviations ...................................................................................................................... 11
Capitalization ....................................................................................................................... 12
Commas .............................................................................................................................. 14
Grades (Scholastic) ............................................................................................................. 14
Hyphens ............................................................................................................................. 14
Italics ................................................................................................................................. 15
Numbers ............................................................................................................................... 16
Paragraphs .......................................................................................................................... 17
Plurals ................................................................................................................................. 17
Punctuation .......................................................................................................................... 18
Audit-Editing ....................................................................................................................... 19
Work log and Project log .................................................................................................... 20
TRANSCRIPTS
Completing a transcript requires two documents:

1. The draft transcript
   - To access audio: Share → Projects → XYZ Project → XYZ Audio
   - To save document: Share → Projects → XYZ Project → XYZ Transcripts → XYZ-# Name Date dr/ae/final
     - Dr: draft, ae: audit edit, final: final copy

     Complete the draft transcript according to the steps outlined on the following pages.

2. The transcript summary, detailing significant themes of the interview and including 4-5 keywords.
   - To save document: Share → Projects → XYZ Project → XYZ Transcripts → XYZ-# Name Date summary

     Complete the transcript summary referring to this example:
     Dr. Richard Lee Bucciarelli talks about his work in neonatology and his experience working in the Pediatrics Department at Shands Hospital. He saw the creation of the Children’s Medical Services program which provided care to children in low-income families. Bucciarelli also was heavily involved in advocacy in Washington DC and the Tallahassee. Bucciarelli worked as Chair of the Department of Pediatrics and pushed for a creation of a children’s hospital at Shands, and finally saw the building of the Shands Hospital for Children.

     Key Terms: Advocacy, Pediatrics, Shands Hospital for Children, Pedicare
FORMATTING A TRANSCRIPT

The first page's header

Should be on the top left of only the first page and should contain the project code number, the name of the interviewee, the interviewer, and the date of the interview.

It should look like this:

UF-999
Interviewee: Roberta Peacock
Interviewer: Paul Ortiz
Date: July 11, 2006

How to add a header in Microsoft Word

1. on the top left of the toolbar click the “Insert” tab
2. then click “Headers”
3. Select the first item in the drop-down box with the text on the left-hand side.
4. *Also make sure you select “different first page” so that when you start adding page numbers on the second page it will not delete your first-page header.*
5. The headers should be in Arial 12 pt. font

When you are finished adding the header, click “close header” on the top right-hand side of the paper so you can begin typing in the body of the document.

The header on every other page should follow this format:

The header on every subsequent page should be on the top right-hand side in this format: Project Code Number; Interviewee’s Last Name; Page Number.

It should look like this

UF-999; Peacock; Page 2

To insert the header and page number on the second page,

1. go back under “insert,” tab
2. then click “Page Number.”
3. Click on “Top of Page,” and select the third item in the drop-down box that displays a number on the right-hand side.
4. within the header, type the project code number; person’s last name; page
(the number will automatically be added)

The body of the document

The body should be double-spaced and in Arial 12 pt. font. The paragraph format should be a “hanging” indent.

To select a “hanging” indent
1. Click the “Home” tab
2. Click the small arrow to the right of the “paragraph” section. A dialog box should pop up.
3. In the “indentation” section, click the drop-down box under “special”
4. Change from “none” to “hanging”

Initials

Use the first letter of the last name to denote who is speaking. Follow the letter with a colon press “tab” to create a large space.

If we apply this format to Roberta Peacock and Paul Ortiz, it would look like this:

O: When were you born?
P: I was born November 12, 1921.

If both people’s last names start with the same letter, use the first letter of the first name also.

SE: When were you born?
FE: I was born January 31, 1953.

If someone has a hyphenated last name, use the first letter of the first word. For example, John Tomlinson-Smith would be:

T:

Completing a transcript

Complete a transcript by marking [End of interview] and signing the document for the stage that you worked on it. It should look like this:

[End of interview]

Transcribed by: Scott Kraff, August 1, 2012
Here is a sample of what the formatted pages should look like.
During the processes of time, was passing by, and Calvin taking up so much time with other people and knowing that his own financial affairs were going down and getting going. He never gave such a thought that he wouldn't have to stop and put more attention to his own. He still in his mind, had the other person at the table.

P: Did he ever get discouraged with his own people?

M: I don't believe he did! I don't believe he was ever discouraged. I want to tell you something how the holy oath that put him in as one of the only old members and they looked to him as one of the heads of the old men in the community that he was in. And they all, whatever Calvin suggested, they all agreed with him. He had a great influence on him who thought needed work in the holy oath and they would go along with him in that and he didn't have to except him in the holy oath. He got some of our Indian people in the holy oath; he helped up some colored people on it and also some white people. And they at some point, he knew that Tom Bate was a man that was one of the members of the holy oath and that's where he could help. He passed away a couple weeks ago, but to my regret, but if he was here he would tell you. He has spoke to me many time that Calvin was one of the greatest men or friend he had ever known and also Mary Sumner was at the center of the Creek Nation and he was on the road. Now, this is something that day—a testimony that they made something for Calvin and they brought it and gave it to me and in the head office of the holy oath.

P: Let me ask you.

[Break in Recording]

M: Now, this is—[Inaudible]. That he belonged to concerning Calvin and they brought and gave it to me and they told me that he would take in each division had a statement.

[End of Interview]

Transcribed by: Scott Kratt, July 2012
Audited by: MSVPA, August 13, 2012
Final edited by: Diana Coutee, August 20, 2012
TRANSCRIBING: FORMATTING and GUIDELINES

INAUDIBLE SPOTS IN RECORDING

• When speech on a recording is inaudible, try playing it at higher volume and/or slower or faster speed. If the interviewer works for SPOHP, ask her or him for help!
• If you can make an educated guess, type the closest possible approximation of what you hear and **bold it** the first time it appears. If you can, Google your approximation to try to verify your guess (usually for names or place names).
  I went to school in **Maryville**.
  **Jane Krackow** used to be the department head in English.
• If you cannot make a guess as to what is said, note “inaudible” and the time elapsed in brackets.
  We’d take our cotton to Mr. [inaudible 33:07] gin in Cameron.

BRACKETS

Use brackets to around anything the transcriber adds to the document.
• a pause in recording, when recording is turned off and then on again, when sound fades out, et cetera:
  [Break in recording]
• the end of the interview:
  [End of interview]

**Don’t forget to leave a signature of the document in your work! See above section for instructions.**

• Descriptive terms:
  [Laughter]
  [Crying]
  [Telephone Rings]

COMMON QUESTIONS

DO

okay
a lot
et cetera
yeah
World War II
for a while
awhile ago
all right
until, till

DON’T

OK, O.K.
alot
e tc.
ya, yea
WWII, World War Two,
for awhile
a while ago
alright
‘til
nowadays now-a-days
apiece a piece
inasmuch as in as much as
insofar as in so far as

IMPROPER GRAMMAR
Do not change improper grammar said by the speaker.
It is okay to leave the following as is:
• Kinda
• Gonna
• Wanna
• Fella
• Double negatives
  I ain’t never been in that kinda situation before.

DASHES
Instances to use the dash (—)
• an interruption by another speaker
  P: I am from a small town near—
  O: What is the name of the town?
  P: Gainesville.

• before and after someone interrupts himself
  D: That was back in July—no, wait, it was August—of 1960.

ELLIPSES
Use the ellipses ( . . . ) when the speaker trails off resulting in a long pause. The ellipses consists of three periods, each separated by a space, and separated from the word it follows by a space.

Correct:
B: That was a long time ago, but . . .
A: What were you going to say?
B: I can’t really remember that well because it was so long ago.

FALSE STARTS
In general, do not include false starts or repeated phrases. The only exception is if the false start enhances the statement. Use your judgment to determine if this rule applies.
Incorrect with false start:
     R:  We went—we were going south to the warmer climates.

Corrected:
     R:  We were going south to the warmer climates.

Incorrect repeated phrase:
     J:  I went to the University of Florida. I went to the University of Florida to study mathematics.

Corrected:
     J:  I went to the University of Florida to study mathematics.

FEEDBACK WORDS AND SOUNDS

Too many interruptions in the flow of a speaker’s remarks with feedback (such as um-hm and yeah) is not necessary unless those words are used to answer a direct question.

Incorrect:
     S:  That was the craziest thing I ever heard!
     D:  Uh-huh. (D’s response is NOT necessary in the final transcript, so it should be omitted).

Correct:
     S:  That was the craziest thing I ever heard! Don’t you think so?
     D:  Uh-huh. (In this care D’s response is necessary in the final transcript, so it should be left in.)

How to spell common feedback or crutch words

• uh
• uh-huh = agreement
• um-hm
• unh-uh = disagreement

FILLER WORDS

If the speaker is constantly using filler words like “you know,” or “uh,” in speech, these can be omitted.

Incorrect:
     K:  You know, I never thought about it that way, but, you know, I can see how, you know, some people might do that.

Correct:
K: I never thought about it that way, but I can see how some people might do that.

DATES
Write full dates as follows:

January 1, 2003

- If the speaker omits the century and just says the decade, write out the full year with the omitted numbers in brackets.
  
  [19]67 not ’67
  The [19]50s, not the fifties *note no apostrophe before the “s”
  The mid-[19]50s, not the mid-fifties
- **Always** use numerals for years, even at the beginning of a sentence.
  1962 was an important year for me.
- Use numerals for days when they include the month and the year; follow this form even when the speaker says, “August the fifth, nineteen eighty-seven.”
- Spell out the words for the day when the year is not expressed and the speaker uses the ordinal number:
  My birthday is August fifth.
  My birthday is August the fifth.
- Spell out the word for the day when the day precedes the month:
  the fifth of August

SPELLING
Use the spell-checking function in Microsoft Word. However, it does not catch every error, so it is important to proofread. Use the dictionary (or go online to www.merriam-webster.com), or Google terms to verify proper spelling.

COMMON MISTAKES
**all right** *(alright is not a word)*
**all together** The children were all together again for Molly’s birthday.
**altogether** *(adverb: wholly, entirely, completely)* That is altogether unfair.
**here** I like it here.
**hear** I can’t hear what they said on the tape.
**every day** I eat lunch every day.
**everyday** *(adjective: common)* I think I’ll use my everyday dishes for the dinner party.
**its** *(possessive)* The cat was chasing its tail.
**it’s** *(contraction of it is)* It’s cold outside.
**onto** *(preposition: to a place or position on; upon; on)* Paste the label onto the top.
**on to** Let’s go on to Dallas since we’ve come this far already.
**they’re** *(contraction of they are)* They’re going to play rugby in the fall.
**there** *(indicates location)* Could you sit over there, please?
**their** *(possessive)* The children took off their coats.
**to** Are you going to school today?
**too** Did you graduate from UF, too? *(Note the comma.)*
**website** *(Web site is not a word, capitalized or not.* Updated AP 2009 style guide)
**whenever** (conjunction: at whatever time; at any time when) Visit us whenever you like.
**whichever** Do whichever is easiest. Whichever task you do, do it well.
**who’s** (contraction of who is or who has) Who’s that girl sitting over there?
**whose** (pronoun, possessive of who or which) Whose umbrella is that?

yeah Note this preferred spelling.

## ABBREVIATIONS

In general, avoid abbreviation in oral history transcripts.

**Do not abbreviate:**
- A civil or military title unless appearing immediately before a person’s **full name**: Governor Perry, but Gov. Rick Perry
- names of countries, territories, provinces, states, or counties
- **doctor** when used without an accompanying name
  (The doctor said, but Dr. Smith said)
- Senator, Judge, Bishop, General, Professor or any other political, academic, civic, judicial, religious, or military title when it is used alone or when it precedes a surname alone, i.e., Judge McCall
- **the Reverend** or **the Honorable**, when **the** is part of the title preceding the name
- books of the Bible
- names of the months and days
- terms of dimension, measurement, weight, degree, depth, et cetera:
  inch, foot, mile
- part of a book: Chapter 3, Section A, Table 7
- word elements of addresses:
  Avenue, Building, North, South
- except **NW, NE, SE, and SW**
- portions of company names, unless the actual company name uses an abbreviation:
  Brother, Brothers, Company, Corporation, Incorporated, Limited, Railroad
- **Senior** or **Junior** when following partial names:
  Mr. Miller, Junior Mr. Toland, Senior

**Do abbreviate**
- the following when they precede a given name and/or initial(s) plus surname:
  Ms. Rev. Mr. Mrs. Dr.
- **Jr.** or **Sr.** after given name and/or initial(s) plus surname: John H. Smith Jr. (note that the comma is no longer required around Jr. and Sr.)
- **NE, NW, SE, SW** in addresses given in text (note no periods)
- points of the compass: N, E, S, W, NE, SE, NNW, WSW, et cetera
- era designations: AD 70, 753 BC
- time designations a.m., p.m.
- Agencies and various types of organizations are referred to by acronyms or using an abbreviation from an organization’s initials:
**CAPITALIZATION**

As a rule of thumb, when in doubt, **do not capitalize**. Check with *Chicago Manual of Style* or the dictionary to check if it should be capitalized. Proper names of institutions, organizations, persons, places, and things follow standard English practice. Partial names of institutions, organizations, or places are usually written in lower case.

**Do capitalize:**
- names of particular persons, places, organizations, historical time periods, historical events,
- biblical events and concepts, movements, calendar terms referring to specific days, and months.
- titles of creative works
- references to athletic, national, political, regional, religious, and social groups: Florida Gators, Congress, Democrats, Daughters of the American Revolution, the Masons
- Capitalize Internet and Web always:
  - She suggested that he search the Internet for more information.
  - He found a Web site that answered many of his questions.
  - Note that website is not a word; use Web site.

<table>
<thead>
<tr>
<th>Capitalize</th>
<th>Lowercase</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board of Trustees of Baylor</td>
<td>board of trustees, the board, the trustees</td>
</tr>
<tr>
<td>the University of Florida</td>
<td>the university</td>
</tr>
<tr>
<td>Department of History</td>
<td>the history department</td>
</tr>
<tr>
<td>School of Nursing</td>
<td>The nursing school</td>
</tr>
<tr>
<td><strong>Course titles</strong>: History 1301</td>
<td><strong>Courses</strong>: economics, history, philosophy, but</td>
</tr>
<tr>
<td>History of Texas</td>
<td>the state bird of Florida</td>
</tr>
<tr>
<td>Microeconomics</td>
<td>the newspaper</td>
</tr>
<tr>
<td>Alachua County, City of Gainesville, the <em>New York Times</em>; the <em>Times</em></td>
<td>directional terms: to travel west, to face southwest</td>
</tr>
<tr>
<td>regional designations: the West, the Southwest Central Florida</td>
<td>the central region of Florida</td>
</tr>
<tr>
<td>an Easterner, Western American</td>
<td>a western university</td>
</tr>
<tr>
<td>West Coast, Gulf Coast</td>
<td>the coast</td>
</tr>
<tr>
<td>Interstate 35, IH35 or I-35</td>
<td>the interstate, the highway</td>
</tr>
<tr>
<td>Eighth Street</td>
<td>the street</td>
</tr>
<tr>
<td>Bible, Scripture(s)</td>
<td>biblical work, scriptural passage</td>
</tr>
<tr>
<td>Veterans Administration</td>
<td>the university administration</td>
</tr>
<tr>
<td>Veterans Administration Hospital</td>
<td>a veterans hospital</td>
</tr>
</tbody>
</table>
the Institute for Oral History  
the Texas Collection  
the Word of God  
the Fall (of Man)  
the Gospel of Luke  
the Book of Daniel  
McLennan County Court  
Washington Street Bridge  
American Revolution  
World War I, First World War  
General of the Army Douglas  
MacArthur  
President Harry Truman  
the Bronze Age  
the Democratic Party  
the Democrats (party members)  
Great Depression (referring to 1930s), the Depression  
Sherman Antitrust Act  
Grandmother, Grandpa Smith, Dad (when substituted for a given name)  
U.S. Senate  
Capitol (referring to a building)  

COMMAS
No, sir.  
Yes, sir.  
Oh, yes.  
Oh, no.  
Thanks, Mrs. Pool.  
Yeah, that's right.  *(Note correct spelling of yeah)*  
Well, I'm from California originally.  
I was born in Dallas, Texas, in 1904.  
I mean, what are you going to do about it?  
So we, you know, went back home.  *note that "you know" is set off by commas*  
And, of course, we were pretty angry.  
She was, like, my best friend.  
Direct addresses are set off by commas  
   Pam, I know you will enjoy this.

SCHOLASTIC GRADES

• Type letter grades in capital letters with no period following, no italics, and no
quotation marks.
• Show number grade in Arabic numerals with no quotation marks.
• Plural should be formed only by adding s, (*no apostrophe*) except where confusion with another word is possible.

I made all A’s by earning 100s on all my exams, but my roommate made only B’s.

HYPHENS
For guidance on use of hyphens to form compound words and phrases, please refer first to *The Chicago Manual of Style*, and then to the dictionary.

Hyphenate to indicate division or separation in the following:
• spelling out a name or words, as in H-o-r-a-c-e. Capitalize only where appropriate.
• a fraction expressed in words one-fifth

Hyphenate to indicate combination as follows:
• nouns made up of two or more nouns which imply the combination of two or more linked things or characteristics
  astronaut-scientist, AFL-CIO
• when two essential adjectives describe a noun
  He is a small-business owner. (both words describe the business)

• modifiers and adjectival compounds when used *before* the noun being modified, including those formed with numbers:
  a one-of-a-kind student
  a 56-year-old woman

Do *not* hyphenate
• a compound modifier that follows the noun it modifies unless hyphenated in dictionary:
  Her argument was well balanced.
  She was good-natured.
• a compound modifier that includes an adverb ending in –ly: wholly fictitious
• a proper noun except when absolutely unavoidable
• contractions, such as: can’t, wouldn’t, don’t, didn’t, wasn’t, he’ll, they’re, she’d
• chemical terms, as in sodium nitrate, sodium silicate, bismuth oxychloride

ITALICS
Italics should be used sparingly, and they are typically only used when referring to a title of a work.

Italicize:
• titles of whole published works, such as *Plain Speaking*
• titles of books, bulletins, periodicals, pamphlets
• newspaper names and the city names that accompany them:
  *New York Times* Note: do not italicize any articles preceding a newspaper name.
  Example: the *Times*.
• titles of long poems
• titles of plays and motion pictures
• titles of long musical compositions: operas, musical comedies, oratorios, ballets, tone poems, concertos, sonatas, symphonies, and suites
• titles of paintings, sculptures, drawings, mobiles:
  You may know that da Vinci’s Mona Lisa is actually *La Gioconda*.
• Italicize titles of legal cases, with *v.* for versus:
  *Brown v. Board of Education of Topeka, Kansas:* the *Miranda case*
• names of spacecraft, aircraft, and ships, except for abbreviations preceding the names, such as designations of class or manufacture, as follows:
  SS *Olympic* HMS *Queen Elizabeth* USS *Lexington* Friendship VII
• Consult the dictionary; do not italicize a quotation in a foreign language.
• a foreign word or phrase when followed by a translation; enclose translation in quotation marks and precede translation by a comma:
  *J’ai mal à la tête,* “I have a headache.”

**NUMBERS**

• In general, spell out whole numbers, whether cardinal or ordinal, from one to ninety-nine, and any of those numbers followed by hundred, thousand, hundred thousand, million, and so on, hyphenated or not.
  sixty-nine
  seventy-fifth
  twenty-two hundred, but 2,367. Note: When there are several numbers in a sentence or a group of numbers includes numbers over one hundred, you may use numerals for brevity and consistency.
• Always spell out the number if it is the first word in a sentence.
  A: How old are you?
  B: Fifty years old.

  Exception: If the year is the first word in a sentence, do not spell it out.
  A: When were you born?
  B: 1906.
• Spell out the number if it is the name of a street and under one hundred.
  454 Fourth Street
• For percentages, use numerals and spell out “percent.”
  Only 45 percent of board members approved of the measure.

Do not spell out:
• street address numbers, highway numbers
  10 Downing Street 304 Carroll Library IH35
• telephone numbers
• fractional sums of money above one dollar: $2.98 (not 2.98 dollars)
• dates:
  735 BC; mid-1950s; AD 1066
  1990s
  February 24, 1997
  July 1997 (no comma)
• time of day—use numerals when a.m. or p.m. follow or when typing a whole plus a fraction of an hour:
  8:20 p.m. but eight o’clock
  7:30 but seven in the morning
• number elements in names of government bodies and subdivisions of 100th and higher, all union locals and lodges
  Thirty-sixth Infantry
  139th Tactical Wing
• parts of a book, such as chapter numbers, verse numbers
• For consistency any sentence which contains numerals pertaining to the same category should have all numerals.
  The report stated that 7 [instead of seven] out of 265 students voted in the campus elections.

Exceptions:
• The sentence begins with a number:
  Seven out of 265 students voted.
• Numbers representing different categories:
  In the past ten years five new buildings of over 125 stories have been erected in the city.

Plurals of numbers:
• Numerals form plurals by adding s alone, with no apostrophe: 1920s and 1930s
• When connecting figures with a prefix or suffix, add the hyphen in the appropriate place if the compound word is adjectival. Connect numbers expressed in words to a prefix or suffix with a hyphen: twenty-odd
• The suffix fold is an exception threefold

PARAGRAPHS
*The Samuel Proctor Oral History Program does not* break up its transcriptions into paragraphs. Everything said should be one block of text, even if topics change or new dialogue is introduced. The only time one should press the “enter” key is if someone new is speaking, and it is never indented. See formatting and page setup for more guidelines.

PLURALS
• Compound words formed with prepositions are pluralized by forming the plurals of the first nouns in the compounds:
fathers-in-law
• Capital letters of the alphabet are pluralized by adding s or ’s: Zs
• Use the apostrophe only where confusion is possible:
  A’s, not As
  Lowercase letters form the plural by adding ’s:
  p’s and q’s
• Acronym abbreviations are pluralized by adding s
  GREs
• When periods are used, add an apostrophe:
  B. K.’s
• Proper nouns: Add s to the singular if the addition does not make an extra syllable:
  six King Georges
  Add es to the singular form if the addition creates an extra syllable:
  six King Charleses
• Nouns—including names of persons—that end in s take addition of es to form the plural:
  The three Loises are friends with the three Marys.
  The hall was full of Joneses and Martins. Note that the apostrophe is never used to denote the plural of a personal name.

QUOTATION MARKS
Generally speaking, the Samuel Proctor Oral History Program does not use quotation marks.

• Quotation marks are only used in speech that can be verified, such as presidential speeches, famous speeches or quotes, and direct quotes from books or publications.
  Martin Luther King Jr. said, “I have a dream.”
• If the speech is NOT verifiable, then do not use quotation marks, even when a direct expression is used by one of the speakers. Instead of using quotes, set the expression apart with commas.
  When I was little my mom used to say, if you study hard in school I will take you to get ice cream.
  He said, you’re fired, and I said, we’ll just see about that.
• DO use quotes for the names of articles, essays, radio programs, television shows, book chapter titles, et cetera.
  Have you seen the article “Sharks” in National Geographic?
  The television show, “Dr. Who,” ran for several seasons.
• Interviewees occasionally coin words, either humorously or to convey a meaning for which they cannot find an existing word. If you cannot find a word in any dictionary but can hear it clearly and can devise a reasonable spelling for it, transcribe it and place it in quotation marks the first time it occurs. Do not use quotation marks for every occurrence of the coined word, however, as it makes for tedious reading.
**PROOFREAD!**

Proofread your transcript. Look for words that the spell-checker may have missed: *form* instead of *from*, *though* instead of *thought*, *you* instead of *your*, et cetera.

If you make a decision on a matter of style in cases where the rules provide no clear guidance or allow for discretion, make sure you follow that decision throughout the transcript. If you verify and correct the spelling of a name, be sure to correct every occurrence.
GUIDE TO AUDIT EDITING

The purpose of audit editing is to make the transcript as accurate as possible and to add in extra information to contextualize both historically and socially topics the speaker is referencing.

Steps in Audit Editing:

• Read the document as you listen to the audio and correct any typos or mistakes where the original transcriber may have not understood what the interviewer was really saying.

• If there are blanks or bolded words in the document and you still cannot tell what the person says, listen to the audio several times on faster and slower speeds for those moments. Also try Googling what you think the words might be to see if you can deduce the true meaning.

• When trying to the correct spelling of someone’s name and that person works for a company or institution, try a Google search.

  Ex: Paul Ortiz UF

• If you still cannot determine the word, keep it **bolded**.

• If you cannot make a determination after research and re-listening, note “inaudible” and the time elapsed on the audio in brackets.

  We went to [inaudible 33:05] yesterday.

• Remember, **do not** change improper grammar that was said by the speaker.

  I don’t **never** want to go there again.

NOTE: SPOHP is no longer contextualizing in its transcripts.
WORK LOG AND PROJECT LOG

WORK LOGS
When you finish your work each day, you must fill out a work log.

Accessing the Work Log
1. Click “My computer” on the desktop
2. Click “Share (S:)
3. Click “Oral History”
4. Click “Oral History New May 2006”
5. Scroll down and click on the “Work Log” folder
6. Click on the excel document “Work Logs”
7. Click on the tab at the bottom with your name on it
8. Fill in the date, your time in, time out, what project you worked on, and how many hours you worked.
9. Save the document and close the file when you are finished.

Be sure to fill out the work log every day that you work.

PROJECT LOG
Project logs should be completed every time you finish a task. For example, when you completely finish transcribing a document, you would fill out the project log so SPOHP can keep track of which tasks are complete.

Accessing the project log
1. Follow steps 1-4 from the “work log” directions until you are within the “Oral History New May 2006” folder
2. Click on the “Project Log” folder
3. Click on the excel document “Project Log In”
4. Use the arrow buttons on the bottom left to scroll sideways until you see the project code on a tab at the bottom of the page
5. Click on the project code tab for whatever project you have been working on
6. Find the specific person the transcription is about on the left-hand side, and enter your initials, the date, and the total pages (if there is a section for that) under either the “transcription complete” or “audit edit” column, depending on which task applies to you.

7. Save the document and close the file when you are finished.

Each time you finish a project, be sure to e-mail the undergraduate coordinators to let them know and so they can assign a new task.